Micro Planner X-Pert

Change History

This document contains important information that is not included in the Micro Planner X-Pert User Guide. Please read it carefully so that you can take advantage of the new facilities that have been incorporated into the software.

Micro Planner X-Pert v3.5

Release Date: April 2008

Micro Planner X-Pert v3.5 replaces all previous versions.

1. Added Duration based task width option to network clean up.
This feature sets the width of the task box in a precedence diagram based on the duration of that task. Use this to create a visual measure of the duration in network diagrams. If the calculated width is shorter than the minimum task width then the minimum task width is used. Likewise, if the calculated width is wider than the maximum task width then the maximum task width is used.
NOTE: This only applies to the existing logic and their current duration settings. If more logic is added or the existing logic duration is changed, this routine will need to be performed again.

2. Task Box coloring - traffic lights
This feature colors the background of the task box based on the following criteria:

1) Tasks with progress information are set with a blue background
2) Tasks with Float less than or equal to zero will show with a red background
3) Tasks with Float less than or equal to 10% of their duration are shown with a yellow background
4) All remaining Tasks have a green background.

To use this feature go to the Network Options dialog found under the view menu or with Ctrl-Y and turn on the checkbox entitled "Show Background Colors"

3. Duration Scenarios and three point estimating
Users can now set multiple duration values or scenarios for each piece of work. On the task/activity dialog the duration prompt has been replaced with a duration button (ie. power prompt) as pictured below.
Pressing this 'Duration:' button leads to this dialog:

On this dialog, the user can enter the base or user enterer duration. This is by default the value that appears in the duration field. Additionally, the user may enter alternative scenarios that represent the Most Likely, Optimistic, Pessimistic duration estimates for this task. These scenarios can be run independently or combined to create a 3 point or 3 times estimate of the duration.

The final piece of this feature is the Analysis Controls Panel found off the Analysis menu. Here is a
Notice in the Resource Analysis section the dropdown menu labelled 'Duration Scenario' that is currently showing all of its options, these options correspond to the fields you entered on the task/activity dialog. Which option is selected determines which duration value, entered for the task, will be the primary duration field used for all reporting and analysis. Likewise, when the user selects a Duration Scenario, all edits to the main duration field on the Task inspector are stored in the corresponding field. If a task/activity has the same duration value for all scenarios you can simply entered it once as the main duration and the system will use that duration in all cases. If the user enters a value in any of the scenarios then this defaulting is no longer used.

It is important to note that when the duration scenario is switched causing a task/activity's duration to change that the associated resource usages will also be adjusted. This is consistent with adjusting the duration on the task inspector dialog. There can be cases of resource detail loss. For example, if a task has duration scenarios: 5 days for User Entered, and 2 days for Optimistic with a resource assignment that starts on 2 and finishes on day 5. When the duration scenario is changed from User Entered to Optimistic it will show the resource assignment as starting on day 0 and finishing on day 2. If you then return to the User Entered duration scenario the resource assignment will go from start of day 0 to a finish of 5 day. Therefore use of Duration Scenarios and resource assignments will a non-zero start is not advised.
Consider the following example. There is a network with a single task. That task has the following durations: 3 days for User Entered, 2 days for Optimistic. The user switches the Analysis Controls 'Duration Scenario' control from 'User Entered' to 'Optimistic'. Looking at the task, the user will see the task as having a duration of 2 days. All reporting will show that same duration. If I switch the 'Duration Scenario' control back to 'User Entered' the system will change the displayed duration to 3 days, as expected. Now assume that the 'Duration Scenario' control is set to optimistic and the user goes to the Task inspector and enters a new duration in the main dialog without opening the 'Enter Durations' dialog mentioned above. The value entered will be stored in the 'Optimistic' field. In the case of using the Calculated Duration Scenario, if the task/activity has values for any of the scenarios then the duration edit control on the main task inspector will be disabled. If the task/activity does not have any duration scenario data then the duration control will be enabled and whatever value is entered will apply to all scenarios.

The Calculated option on this dropdown applies the following generally accepted formula \((O + 4 \times M + P)/6\) where \(O\) = optimistic duration; \(M\)=most likely duration; and \(P\) = Pessimistic duration. This is referred to as 3 point or 3 times estimating.

4. Automatic Updating
Added configuration option to disable automatic update checking on product launch. If you do not wish the program to automatically check for updates simply edit the launcher.exe.config file and change the entry with the key value = "CheckForUpdate" to have a value = "0". Then you can turn back on the automatic updating by restoring that value = "1".

B. Known Issues
These are issues that are introduced by this release and represent breaking changes

1. Report formats created in 3.12 are not supported. If you have a project developed in 3.12 and wish to move it forward into the most current release. You need to remove all reports from the project before it will open successfully in the current release. Reports saved in version 3.12 need to be be redeveloped using the most current version.

---

Micro Planner X-Pert v3.12

Release Date: Feb 2007

Micro Planner X-Pert v3.12 replaces all previous versions

1. Added Report Duration Totaling
Duration report elements can now be placed in the header or footer and present a calendar independant duration for the total amount of work in the report.
Micro Planner X-Pert v3.11

Release Date: April 2006

Micro Planner X-Pert v3.11 replaces all previous versions

1. Condensed Report Header Layout
   Reduced the amount of white space in the header portion of all standard reports.

Micro Planner X-Pert v3.02

Release Date: February 2006

Micro Planner X-Pert v3.02 replaces all previous versions. This release was not given to customers

Micro Planner X-Pert v3.01

Release Date: January 2006

Micro Planner X-Pert v3.01 replaces all previous versions

Micro Planner X-Pert v3.0

Release Date: December 2005

Micro Planner X-Pert v3.0 replaces all previous versions

1. Expand Capacities
   The amount of information that can be entered in a project has greatly expanded. Here are the new limitations:
1. Number of Operations went from 10,000 to 15,000
2. Number of Subprojects went from 50 to 100
3. Number of Work Breakdown Element rose from 1000 to 1500
4. Number of Zones went from 250 to 500
5. Number of Responsibilities rose from 250 to 500
6. Number of Cost Codes rose from 250 to 500
7. Number of Calendars rose from 200 to 250
8. Number of Resources rose to 200 to 250

2. New Indexes on Cost Profile
   The cost profile has two new indexes to help understand the true state of your projects. The Schedule Performance Index (SPI) and the To Complete Performance Index (TCPI). Both are displayed in the results box.

   Schedule Performance Index (SPI) is defined as \( \frac{BCWP}{BCWS} \) and expressed as a percentage. Its meaning can be thought of as a broad measure of the efficiency of the project. If it is 100%, you are right on schedule - every dollar spent has achieved the expected results. If it is less than 100%, you are behind plan. If it is greater than 100%, you are ahead of plan. As with SV, we are talking about the schedule performance in terms of money.

   To Complete Performance Index (TCPI) is defined as \( \frac{BAC - BCWP\text{ (cumulative)}}{EAC - ACWP\text{ (cumulative)}} \) and is expressed as a percentage. It shows the ratio of the actual to the planned funding remaining—the ratio will be smaller than 100% when earned-value efficiency is poor.

3. Improved Graphics
   The Pie chart text has been improved to greatly reduce overlap and produce even clearer charts.

4. Improved Appearance
   New Icons have been incorporated. We have also added Zone, Responsibility, Cost Code and Resource Patterns as optional fields on the Network Diagram.

5. Elapsed Time
   A new field on the Subproject and Work Breakdown Chart has been developed that shows the elapsed time of the entity. Using this field you can see the amount of time required to complete the block. This can vary from the Task/Activities Duration due to Resource splitting, partial use and resource efficiency. On WBS elements it gives you a good idea of the span of time associated with an element.

6. Other Improvements
   This release includes a number of small improvements including:

   1. We have added a new Time Span option representing 12 weeks.
   2. Added a Remove All button to Sort order definition dialog.
**Micro Planner X-Pert v2.7**

**Release Date: August 2004**

Micro Planner X-Pert v2.7 was a limited release provided to some customers. Its functionality is incorporated in v3.0.

---

**Micro Planner X-Pert v2.6**

**Release Date: August 2003**

Micro Planner X-Pert v2.6 replaces all previous versions

1. **Assume Cost Analysis**
   Changed assumption regarding including cost analysis during Resource Analysis. Default is to include cost analysis.

2. **Assume Cross Out Progressed Tasks**
   Changed assumption regarding Cross Out Progressed Tasks. Default is to enable this feature.

3. **Changed Out of Sequence Progressing Analysis**
   This version enforces strict logic meaning that if a task is completed out of sequence the remaining work will be scheduled according to existing logic. For example, consider a chain of logic like A->B->C where A and C are one week and B is two weeks. Without progress then A would be scheduled to start at Week 0, B would follow at Week 1 and C would start at Week 3. Now assume B have been progressed out of sequence and is half completed. Following the remaining logic the schedule would be as follows. A would still start at Week 0, B would now obey the logic saying that it could not start until A is complete for the remaining work to be performed and would start at Week 1. C would follow when B is completed at the beginning of Week 3.

   To match the analysis of previous versions you would simply need to remove the link between A and B.

4. **Added support for special characters in XML processing**
   Exporting and Importing XML now supports the use inclusion of special characters: & and <, >,'.

5. **Added support for printing in the PDF format using 3rd party printer driver**
Now all views, reports and charts can be printed to the Adobe Acrobat file format (PDF) using 3rd party printer driver Win2PDF. Supports only Windows NT, 2000, XP. Users may need to register using http://support.microplanning.com to receive authorization code. Check with your distributor on how this feature can be activated.

---

**Micro Planner X-Pert v2.5.1**

**Release Date: August 2002**

Micro Planner X-Pert v2.5.1 replaces all previous versions

1. **Cost Pie**
   Changed Cost Pie to include underlying data values in addition to already provided percentages

---

**Micro Planner X-Pert v2.5.0**

**Release Date: April 2002**

Micro Planner X-Pert v2.5.0 replaces all previous versions

1. **File Open and Save Dialog**
   Improves Dialogs to allow for resizing and to prompt before overwriting existing files.

---

**Micro Planner X-Pert v2.4.6**

**Release Date: March 2001**

Micro Planner X-Pert v2.4.6 replaces v2.4.5.

**New features**

1. **Long File Names**
   Products now support long filenames for opening and saving files. This is done with an external program so in rare cases you can have the program seem hung or stuck. If that is the case then the user needs to complete the activity related to the File Open or File Save As dialog and then the program will
respond normally.

2. XML Export/Import
Now you can export your project information in XML, the new standard for exchanging data. You can also open XML files directly as long as they match the defined format. This new way to get data in and out of Micro Planner includes complete calendar, weekly cycle and resource definitions.

3. Work Breakdown User Interface
Changed double-clicking so if you double click on the description of the breakdown the Element Inspector Dialog is opened. If you double-click on the leading Plus sign then the item is expanded or collapsed based on its current state.

4. Web-based Updating
Added new feature to automatically check for web updates and if available to give you the option to install. This feature is available from the Start menu. When launched it probes our web site to find out the current shipping version and compares it to the version currently installed. Remember, if you are covered by a support contract then all updates and upgrades are free!

5. Web-based Installation
A new web-based installation have been create that interrogates your system to find out which files are needed. This way the smallest download possible is created. It also manages the connection, so if your connection is dropped you do not have to start over.

Micro Planner X-Pert v2.4.5

Release Date: September 1999

Micro Planner X-Pert v2.4.5 replaces v2.4.4.

New features

1. Improved Data Entry
The dialogs, Task/Activity Inspector, Calendar Inspector and Resource Inspector, now support "Power Prompt" technology. Power prompting allows the user to enter the requested information directly into the field. Or by pressing on the prompt associated with the field, they are guided in their selection. All fields supporting "Power Prompt" technology, are verified upon exit of the field. This guarantees that the user will always be aware of any problems with the data entered.
Micro Planner X-Pert v2.4.4

Release Date: June 1999

Micro Planner X-Pert v2.4.4 replaces v2.4.3.

New features

1. Improved Merging
The merging feature was extended to allow the user to determine what happens during the merge process. Now users can merge, replace, ignore calendars. Therefore if a user is merging in a schedule that they know contains more current calendar information they can chose to overwrite the existing information. If the user wants to limit the inclusion of new information or prevent calendar changes without approval then they can ignore the changes in the calendar information. Finally, they can merge the calendar information which creates a new calendar for each unique combination of weekly cycles and exceptions.

Micro Planner X-Pert v2.4.3

Release Date: April 1999

Micro Planner X-Pert v2.4.3 replaces v2.4.1.

New features

1. Extended Annotations
In addition to supporting text, graphic and key annotations, Micro Planner can now display field annotation. Simply create a standard text annotation and add any of the keywords below and the corresponding field will be displayed. The resulting text will be displayed using all of the standard annotation controls.

@TIMENOW @DURATIONFORMAT
@PROJECTCOMMENT @COSTTODATE
@PROJECTTITLE @ACCRUALTODATE
@CURRENCYSYMBOL @PAIDOVER
@PROJECTCODE @ADJUSTBUDGET
@PROJECTGENERATION @ADJUSTRECOVER
These need to be added at the very beginning of the annotation and can not have a return at the end.

2. Improve Receiver Tuning
With this release you can now see all receivers that require tuning. With a single item in that list selected you can tune it in the usual way. If you select many items in the list then you can change the file portion of the tuning information for all selected items. That means if you need to move files to different directories or servers, you won't have to spend hours reconnecting your receivers.

3. Breakdown listing dialog Improvements
The dialog box that lists items of the breakdown (Can be reached from the List...Breakdowns menu item or by assigning a breakdown in the task inspector) has been enhanced to include the breakdown element description.

4. Automatic Progressing
We have added a checkbox called "Assume Progressing" to the analysis control panel that determines whether we should assume items with zero duration should be automatically progressed when all preceding logic has been completed. That means that Milestones and Receivers will complete themselves if all preceding logic has been completed.

5. Selective Archiving
Now you can archive by subproject or even by operation! The archiving dialog has been extended to include the ability to select only one or more subprojects to be archived. Additionally, a checkbox for overwriting existing information has been added so that you can archive information only to items that currently have no archive.

6. Percent Complete/Balance
When displaying either of these values, the value will represent the amount of progress currently entered on the operation irregardless of the field entered. For example, if you enter 50% on 2 week task and then display the balance remaining in the Network. In previous releases, you would see no value since none was entered in the balance field. With this release you would see the value 1 week since that reflects the 50% complete progress amount entered.

7. Zone/Responsibility/Cost Code Selection
A "Find" button has been added to the selection dialog for Zone, Responsibilities, and Cost Codes. Now if you are assigning these fields to a specific task you do not have to page though the many codes to find the one you require. Simply enter the name of the code you wish to select and press the "Find" button. It will scan the list and assuming it finds a match, it will select the item. At that point you can simply click the "Ok" button to complete the assignment.

---

Micro Planner X-Pert v2.4.1
Release Date: January 1998

Micro Planner X-Pert v2.4.1 replaces v2.4.

New features

1. MPXv4 Files
In addition to the MPX v1 and v3 files created by Microsoft Project 95, Micro Planner can now read the MPX v4 files created by Microsoft Project 98.

Micro Planner X-Pert v2.4

Release Date: December 1997

Micro Planner X-Pert v2.4 replaces v2.3.6. It is important to note that files saved under this latest version cannot be read by earlier versions.

New features

1. Network Diagram - Keyboard Navigation
You can now navigate or move around the network diagram using the arrow (cursor) keys on the keyboard, once you have selected one item.

2. Network Diagram - Cross Out Progressed Tasks
A 'Cross Out Progressed Tasks' feature has been added to the network diagram options. This draws a single diagonal line through a task if it has started and two diagonal lines (a cross) if it is finished:

To use this facility, do the following:

- Choose Network Options from the View menu
- Enable the check box labeled 'Cross Out Progressed Tasks'
- Choose OK

[Note: This applies only to Precedence; there is no equivalent in Arrow]

3. Network Diagram - Backspace Key
You can use the Backspace key to Clear items from network diagrams (in addition to using Cut or Clear from the Edit menu). You should use this with care: Backspace on a report only prunes an item from the report, whereas Backspace on the network diagram removes it permanently.

4. Date Format: Century
An option to show the century has been added to the Date Format dialog:-Four Digit Years. This is intended primarily for the export of data to applications that could otherwise confuse 2000 with 1900. Date fields in the standard reports have been extended to accommodate the century if it is used, but you may need to amend custom report stationery.

- To use this facility, enable the 'Four Digit Years' checkbox on the Date Format dialog accessible from the Control Panel on the Special menu.

5. New Installer
Micro Planner has a completely new installer to enable us to distribute via the Internet and CD-ROM.

6. Tutorial
A new 'QuickStart Tutorial' distributed in HTML format (and therefore requiring a Web Browser to view). The QuickStart is intended to be 'platform agnostic' or neutral, so it includes screen dumps taken from both Mac OS 8 and Windows 95.

7. Export to Predict!
'Export to Predict!' has been added to the File menu; you can now export data to the Predict! risk analysis application (from Risk Decisions).

8. Follow Selection Changes
Follow Selection Changes (Window menu) means that an item selected on one view, such as a Network Diagram, remains selected on other views such as a Table, Gantt Chart or any report (provided the item is included in the view!).

9. Group Resources and "Location"
You can now use "location" to influence which resource is chosen from a group during resource analysis. If you do not use this feature, the behavior of Group Resources is unchanged, but if you enable the feature, resource analysis considers availability then location then efficiency when allocating a resource from a Group. In other words, location overrides the efficiency rating of the resource.

- To use this, choose Advanced Settings on the Analysis Controls panel from the Analysis menu. One of the labels: Zone, Responsibility or Cost Code can be used as a "location" so that a subsequent operation with the same label will be allocated the same resource from the group, if possible. A resource initially has no "location" but gets one from the task that uses it (whether or not it has been chosen from a group). The proximity of labels to one another in the relevant List is used to measure how close are the locations. Tasks with no "location" label are considered to
be zero distance from any other.

The following example illustrates the use of location:

Three tasks in parallel each of 1 week duration followed by a fourth task each use 1 resource from the Group Men. Tasks 1 to 3 have Zone labels London, Cardiff, Bristol. Task 4 has the Zone label Bristol.

The Group Resource Men comprises Bill, Fred and Jim who are all available full time, with the following efficiencies:

Without Location being used, the following results are obtained from Resource Analysis:
To use Location ahead of Efficiency as a means of choosing the resource for task 4, you choose Advanced Settings from the Analysis Controls panel on the Analysis menu:

This yields the following result in Resource Analysis:
Micro Planner X-Pert v2.3.6

Release Date: 27 September 1996

Micro Planner X-Pert v2.3.6 replaces v2.3.5. It includes some minor improvements.

Micro Planner X-Pert v2.3.5

Release Date: 18 March 1996

Micro Planner X-Pert v2.3.5 replaces v2.3.4. A problem associated with adding tasks on the network diagram, caused by improvements to the speed with which MPX files are read by Micro Planner, has been fixed.

Micro Planner X-Pert v2.3.4

Release Date: 31st January 1996

Micro Planner X-Pert v2.3.4 is an interim release replacing v2.3.3. It fixes a number of potential problems which had been identified in earlier issues of the software. In addition:

1. Reading .mpx files from Microsoft Project
The default calendar used by Microsoft Project is brought in and applied to all operations, including any new operations added to the project once it is an X-Pert file.

2. Cost Profiles
Cost Profiles have been modified as follows:

   1. A Cumulative Cost Profile will display costs to the end of the chosen time period.
   2. A Non-cumulative Cost Profile will display costs from the start of the chosen time period.

Note: All costs will be aligned to Accrual periods if that option has been selected in the Analysis Controls dialog.

Micro Planner X-Pert v2.3.3
Release Date: 5th December 1995

Micro Planner X-Pert v2.3.3 replaces v2.3.1 and offers a number of new facilities:

1. **Scaling**
   When you scale (Enlarge or Reduce) the Network Diagram (Subproject) if there is a single node selected it will remain in the visible area of the window.

2. **Using merge**
   Merge now offers additional options:
   
   1. Calendars are only brought in with resources and operations if they differ from identically named calendars which already exist in the destination project. For example, if a 'Five Day' calendar exists in both projects but in the source file it has a different Basic Cycle and/or Overlays, it will be imported by merge and given a unique name - 'Five Day 2'.
   
   2. You can copy the Structure of the Work Breakdown Structure (WBS) as well as the breakdown elements (Breakdowns) when a file is merged in.

   Note: This dialog now gives you the option to bring either only those breakdowns used or the whole structure. If you have specified a subproject to be merged only those breakdowns used in that subproject will be merged. If you have no subproject(s) specified, the entire WBS will be merged. The only exception to this is when you select 'Copy WBS Structure' with a subproject specified, it selects all breakdowns used on the subproject and merges them - it will also bring in associated breakdowns which may not be used by any tasks if they are parents of any of the breakdowns used. For example, we are merging a subproject that has a WBS consisting of a breakdown 1 and its child 11. On all the tasks in the subproject only 11 is used. If we choose to merge the subproject and copy breakdowns without structure, only 11 will be transferred - but if we merge the subproject and copy breakdowns with structure both 11 and 1 will be transferred since 11 is a dependant of 1.

3. **Clean up Options**
   In addition to the option to clean up levels, 'Clean Up' can now 'clean up the logic' - rearrange the network layout, clean up overlapping lines and alter the size of the description field. To use these new facilities:

   - Choose Clean Up Network from the Special menu.
   - Select your required Clean Up options (complex networks can take a long time to lay out, particularly when removing 'Overlapping Lines', so, if you want to view the network without waiting for it to be tidied up, you can deselect the option to 'Clean Up Overlapping Lines').
   - Decide whether you want description widths unchanged, set to the Default size (as per Preferences) or fitted to the description size while the network is being reorganized.
   - Then choose OK to close this dialog and your network will be altered accordingly.
• If you prefer your original layout, choose Undo from the Edit menu.

Note: These clean up options are particularly useful for organizing project information brought in from other project management systems.

4. Using the right mouse button
If you use the right mouse button to select an icon on the desktop, a pop up menu now appears from which a number of options may be selected; the options available depend upon the type of item selected.

Before explaining each of the options available, please note that if you use the Mouse/Trackball Control Center Utility to assign various functions to the right mouse button within Windows, you may need to alter some of the settings within this utility. To take advantage of the new right mouse button features with X-Pert, you need to ensure that the right mouse button option is set to 'Unassigned'. Naturally if you have used this utility to swap the mouse button functions to left hand operation, it is the left mouse button that must be set to 'Unassigned'.

4.1 Subprojects:
In addition to being able to Open, Delete and Duplicate the selected subproject, you have the option to generate a Gantt Chart showing only the one subproject selected. To do this:

• Move the pointer onto the relevant subproject then press the right mouse button.
• Select a Gantt Chart of the contents of the subproject based on Time Analysis or Resource Analysis results, or on the information stored in the Interim or Master Archives.

4.2 Work Breakdown Structure:
The Work Breakdown Structure can only be opened and it can not be deleted.

4.3 Folders:
Folders may be opened; only empty folders may be deleted.

4.4 Calendars & Weekly Cycles:
Calendars and Weekly Cycles may be edited and duplicated; they may also be deleted if they are not being used.

Note: The same menu appears if you select a calendar or weekly cycle from the 'List Calendars' or 'List Weekly Cycles' dialogs and press the right mouse button.

4.5 Resources:
In addition to being able to Edit, Delete and Duplicate the selected resource, you have the option to generate a Summary Histogram or a Cost Profile of the resource. To do this:

• Move the pointer onto the relevant resource then press the right mouse button.
- Select a Histogram or a Cost Profile of the resource based on Resource Analysis results, or on the information stored in the Interim or Master Archives.

Note: The same menu appears if you select a resource from the 'List Resources' dialog and press the right mouse button.

4.6 Reports & Charts:
Reports and Charts may be opened and deleted. Reports also allow the report layout to be altered or saved as report stationery.

4.7 Report Stationery (excluding standard stationery).
Report Stationery that you have designed may be deleted, duplicated or edited; reports may also be generated from the selected stationery.

Note: This option is not available on report stationery for the standard reports produced by X-Pert.

5. List Resources dialog
Additional facilities have been included in the List Resources dialog:

1. You can create a Histogram or a Cost Profile for a selected Resource by highlighting the resource in the List and then pressing the right mouse button (as described in point 4.3 above).
2. The option to filter the list of resources to view only overused or underused resources, based on the current Resource Analysis results or on the information stored in the Interim or Master Archives, has been added to the dialog.

To do this:

- Choose List Resources from the List menu.
- Select the required resource selection (All, Overused, Underused).
- Click on the Schedule drop down menu and choose the required schedule.
- The list of resources changes to reflect the options selected.
- Click Close to leave the dialog.

6. Hatched patterns
A new option is now available on the Print Dialog to allow the use of Hatched patterns (instead of solid color) on reports to speed up printing/plotting and reduce amount of ink used; this applies particularly to outputs with large areas of solid color/pattern, for example Histograms and Cost Pie Charts.

A Hatched pattern is one which is created using a series of parallel lines rather than the solid pattern produced by bitmaps.

If the option is selected, X-Pert will try to find a hatched pattern which matches as closely as possible
the bitmapped pattern of the original. To use Hatched patterns:

- Choose Print from the File menu.
- Select the required option and click OK to close this dialog.
- Your chart or report will now print using Hatch patterns.

Note: This applies only if the device chosen (via Print Setup) is a vector device (i.e. a plotter).

7. Choosing thick or thin lines for critical logic

You now have a choice as to whether critical (red) nodes and lines should be drawn on the Network diagram with the same thickness as non-critical or progressed items (black and blue respectively); this applies to networks produced both on screen and on a printer/plotter. To change this:

- Choose Preferences from the File menu.
- Click on the Critical Logic drop down menu and choose the required line thickness.
- Click OK to close this dialog.

Note: If you have a black and white screen or printer/plotter, it would be advisable to select the 'Thick lines' option so that the critical path may be distinguished from normal activities.

8. Resource Effort Prefix

You now have the option to change the preset resource effort prefix from 'Man' or 'Work' Hours, Days or Weeks to anything you like - 'Machine', 'Person' or anything else, including leaving it blank. The default setting has been changed to 'Work', but it may be changed as follows:

- Choose Preferences from the File menu.
- Edit the Resource Effort Prefix by typing your preferred prefix.
- Click OK to close this dialog.
- Resource dialogs, histograms and reports will now use the term you have chosen.

9. Adding Precedence logic

9.1 Adding Tasks

Adding tasks (in Precedence mode) by using the mouse to drag out from an existing node meant opening the new task by double clicking on it in order to enter its description, duration etc; there is now an option to edit the new task before you accept it. To do this:

- Hold down the Alt key while dragging out from a node (in precedence mode).
- The 'Change Task' dialog appears allowing you to enter details.
- Click OK to accept the new task.
9.2 In addition you can now modify both the link and the task while dragging out from an existing node. To do this:

- Hold down both the Alt and Control keys while dragging out.
- The 'Add Link' dialog appears for you to enter details.
- Click OK to accept the new link.
- Now, the 'Change Task' dialog appears.
- Enter the task details and click OK to see the new logic in the network.

10. Copying and Pasting logic
An additional option is now available for the renaming of nodes when logic is copied and pasted.

1. The default behavior is that if a node name being pasted is identical to a name already present in the subproject, a completely new name will be invented. So, for example, 1-2-3-4 when copied will be pasted as 5-6-7-8, if 1-2-3-4 already exist in the destination subproject.
2. The new option allows you to copy and paste your network logic retaining the original node numbers but adding a prefix or a suffix. This means that you can choose to copy 1-2-3-4 and paste it as A1-A2-A3-A4 rather than leaving X-Pert to renumber it as 5-6-7-8.

To use this new option:

- Open a subproject and create the logic you wish to copy.
- Choose Network Options from the View menu.
- Type a character in the Mask Prefix or Suffix then click OK to close the dialog.
- Select the logic to be copied in the usual way.
- Choose Copy from the Edit menu.
- Whilst holding down the shift and control keys, choose Paste from the Edit menu.
- Click 'Use old name as basis'. If you wish to use this method every time you copy and paste, select 'Always use old name as basis'.
- Click OK to close the dialog and the new logic now appears in the network.

Note: If you wish to copy and paste logic between different project files, you need to ensure that the relevant Mask Prefix or Suffix is set in the Network Options dialog in the destination project before you paste.

11. Using SMARTDrive with Windows 3.1n
SMARTDrive is a disk caching program which can be used to improve the performance of applications. SMARTDrive saves information read from you hard disk into memory so that when an application calls for this information it is supplied direct from memory not the hard disk; reading information from memory is much faster than from the hard disk so your application runs faster. To set up SMARTDrive:

- Add C:\WINDOWS\SMARTDRV.EXE C 2048 2048 /L /Q to your AUTOEXEC.BAT file.
The section in italics specifies the path to the location of the SMARTDRV.EXE program so if your SMARTDRV.EXE program is in a different directory or on another drive you need to change the path accordingly.

- The command `C:\WINDOWS\SMARTDRV.EXE C 2048 2048 /L /Q` sets up a disk caching utility for both DOS and Windows of 2MB (the first figure is for DOS, the second for Windows). If you have only 4MB total RAM then you may wish to change both 2048's to 512 (0.5MB).
- The 'C' just before the first 2048 is to turn off write caching to drive 'C'. This is important because without it when you save a file SMARTDrive saves it to memory for a while before writing to the hard disk - data can be lost if, for example, you switch off your machine before SMARTDrive has written the information to disk.
- The '/L' forces SMARTDrive to load into low memory. If you omit this option, SMARTDrive can load into high memory where it will run but much more slowly.
- The '/Q' will stop a screen full of information about SMARTDrive being displayed when the machine boots up.

Note: The latest versions of Windows and DOS should set SMARTDrive up for you, however, it is still worth checking that the write cache option is turned off. More information on SMARTDrive is available in your Windows manual.

---

**Micro Planner X-Pert v2.3.1**

Release Date: 28th February 1995

Micro Planner X-Pert v2.3.1 is an interim release replacing v2.3. A possible problem with GDI resources was corrected to ensure the software did not run out of memory unexpectedly.

---

**Micro Planner X-Pert v2.3**

Release Date: 9th February 1995

Micro Planner X-Pert v2.3 replaces v2.1 and offers a number of new facilities:

1. **Preferences**
   Two new features are available from the Preferences dialog.

   1.1 **Report Positioning:**
   This gives you a choice of two options: Faster or Better.
Faster, as the word suggests, means that reports are drawn more quickly but some description or comment information may be cropped as X-Pert estimates their size and position on the report. Better will take longer to draw the report as X-Pert calculates precisely how many lines are required by each activity's description and comment to guarantee an accurate layout.

Note: This facility is particularly useful if you are using languages other than English.

1.2 Default Window Size:
This lets you set the default size for all new windows. Zero sizes result in the standard system area.

2. Report Scaling
Micro Planner X-Pert can now scale any chart or report to any Windows compatible device. To scale an output:

- Choose Page Setup from the File menu. You may select Page Setup even while using the Preview facility so you can fine tune report layouts before printing.
- Select your required options and click OK to close this dialog.
- Your chart or report is now scaled.

Note: If you select Fit Horizontal or Fit Vertical as a scaling option and later change the orientation of your paper in the Print Setup dialog, the scaling will have been converted to a percentage scale to maintain the original size of your report. If you wish to ensure the report fits to your new page return to the Page Setup dialog and reselect the appropriate option. Also, changes made to the Drawing Size may affect any scaling settings for network diagrams in a similar way.

3. Network Drawing Size
The maximum network drawing size is now approximately 10 meters square (34 feet square) making it three times deeper and twice as wide as it was before.

4. Tiling
Tile now tiles open windows horizontally. To tile vertically, press the Shift key when you select Tile.

Micro Planner X-Pert v2.1

Release Date: 8th August 1994

1. Using the sample files
The Installation program gives you the option to install a number of sample files - these are projects illustrating the variety and scope of features provided by Micro Planner. Accompanying these projects
are a number of other example files which include sorting and selection criteria, report stationery and an image table containing some clip art - you are free to adapt these for your own use.

2. Editing the .ini file
The .ini file, xpert.ini, is created by Micro Planner X-Pert in the Windows directory. Preferences selected by you are stored here. You can edit this directly using, for example, Windows NotePad, but you should take care and only do so if you are clear about what to do.

Micro Planning International Ltd cannot take responsibility for problems introduced by editing xpert.ini. If a mistake is made, simply delete the file and run Micro Planner X-Pert again. This will automatically generate a new, default, xpert.ini file.

3. Customizing the toolbar colors and size
Micro Planner X-Pert defaults to using small, 16 color buttons on the toolbar. You can change the number of colors and size by modifying the [Preferences] section of the xpert.ini file (see above).

The default settings are:

[Preferences]
toolBarColour=4c
toolBarSize=s
Possible values for toolBarColour are:
toolBarColour=4c (16 color)
toolBarColour=4g (grey)
toolBarColour=m (black and white)
Possible values for toolBarSize are:
toolBarSize=s (small)
toolBarSize=m (medium)

You can also opt to show or hide the toolbar, but the buttons on it are fixed. If you have a requirement for a customized toolbar, Micro Planning International Ltd may be able to supply a toolbar tailored to your needs.

4. Changing the drawing quality
Values for the drawing quality are Coarse, Medium and Fine (the default). The drawing quality controls the drawing of X-Pert's diagrams and reports. Some display drivers are unable to cope with the default quality - for example, the network diagram has level lines, represented as dotted blue lines, which may not be visible; in this instance you should try the other drawing quality alternatives until you achieve an acceptable effect. To modify the drawing quality and view the effect:

- Open the Preferences dialog.
- Change the selection in the drop down list.
- Click OK to save the changes.
• Minimize Micro Planner X-Pert and then restore it.
• The new drawing quality will now be in effect.

Note: You may find that your diagrams and reports draw more quickly and screen output matches plotted output more closely if the Coarse option is selected.

5. Resizing the Components dialog
To change the size of the Components dialog in the Report Editor:

• Click with the right mouse button anywhere on the Components Dialog other than the title bar or system menu
• A normal re-sizeable border will appear.
• Use the left mouse button to click and drag the border of the dialog until it is the size you want.
• Click on the dialog with the right mouse button as before.
• The Components Dialog will default to this size unless it is changed again or the xpert.ini file is deleted.

6. Resizing the Resource Usage dialog
This dialog can be re-sized to show more or fewer resource entries for a task or activity, up to a maximum 20 entries. To change the size of the dialog:

• Use the left mouse button to click and drag the border of the dialog until it is the size you want.
• The Resource Usage Dialog will default to this size unless it is changed again or the xpert.ini file is deleted.

7. Reading Microsoft Project Files
Micro Planner X-Pert can read Microsoft Project files, but they must be saved in the MPX format. To import an MPX file the following minimum requirements must be met:

All dates must show: DAY, MONTH, YEAR and TIME fields

Note: Select the correct date format (31/1/96 12:33) from the Options dialog on the Tools menu. Do not assume that if you change the Date format displayed on a table in the Edit Table Options dialog that the format has been changed - it has not.

For an MPX project file without resources the following task fields must be present:

I.D.
Preceding Number (predecessor)
Duration
Outline Level
Name
Summary
For an MPX file with resources the same task fields as above, plus the following resource fields:
Resource Name
I.D.
Maximum Unit

For further information regarding MPX file formats, you should refer either to your Microsoft Project documentation or contact Microsoft Technical Support.